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1. Dulezité

Tato elektronickd uZivatelskd prirucka je

urcena pro kazdého uZivatele tohoto monitoru
Philips. Pred pouZivdnim monitoru si prectéte
tuto uzivatelskou prirucku. Obsahuje dulezité

informace a poznamky k pouzivani vaseho
monitoru.

Zaruka Philips je platnd, pokud je vyrobek
pouzivan pro navrzenou potrebu v souladu
s ndvodem a po prilozenf origindlu faktury

nebo pokladnim dokladem, oznacujicim datum
ndkupu, jméno prodejce a modelové a vyrobnf
¢islo vyrobku.

1.1 Bezpecnostni opatfeni a udrzba

D Varovéni
Pouzitl kontrol, Uprav nebo postupt jinym

zpUsobem nez je stanoveno v této dokumentaci

muze vést k ohrozeni Sokem, elektrickym a/
nebo mechanickym rizikdm.

Prectéte si a dodrzujte tyto instrukce pri
zapojovani a pouzivani vaseho PC monitoru.

Pouzivani

Nevystavujte monitor primému slune¢nimu
zdreni, velmi silnym jasnym svétldm a
udrzujte jej mimo dosah jinych zdrojl tepla.
Dlouhé vystaven( tomuto typu prostredf
muze mit za ndsledek zménu barev a
poskozeni monitoru.

Odstrarite veskeré predméty, které by
mohly spadnout do vétracich otvord nebo
zabrdanit dostatecnému chlazeni elektroniky
monitoru.

Nezakryvejte vétraci otvory ve skiffice.

Umistéte monitor na takové misto, ze
kterého bude elektrickd zdstrcka a zdsuvka
snadno pristupnd.

Jestlize jste vypnuli monitor odpojenim
napdjectho kabelu nebo kabelu napdjectho
adaptéru, pred pripojenim kabelu pockejte
6 sekund, aby monitor fungoval normalné.

Vzdy pouzivejte napdjeci kabel schvdleny
spolecnostf Philips. Pokud napd jecf kabel
chybi, obratte se na nejblizsi servisnf
stredisko. (Viz informace o strediscich
zdkaznické péce)

B&hem pouzivadni nevystavujte monitor
nadmémym otiesim nebo ndrazim.

Pri pouzivani nebo premistovani do
monitoru nekopejte a zabrarite pripadnému
padu.

Udriba

Aby byl monitor chrdnén pried moznym
poskozenim, nevyvijejte na panel LCD
nadmémy tlak. Pri premistovani zvedejte
monitor za ram; pri zvedani monitoru
nesahejte rukou nebo prsty na panel LCD.

Nebudete-li monitor delsf dobu pouZivat,
odpojte jej ze zdsuvky.

Pred ocisténim mirné navihcenym
hadrikem monitor odpojte ze zasuvky.

Je-li vypnuté napdjeni, Ize obrazovku otrit
suchym hadrikem. K ¢isténi monitoru nikdy
nepouzivejte organickd rozpoustédla, jako
napriklad alkohol nebo cisti¢e s obsahem
¢pavku.

Zabrartte nebezpec( Urazu elektrickym
proudem nebo trvalého poskozenf
monitoru a chrarite monitor pried prachem,
destém, vodou nebo nadmémé vihkym
prostredim.

Pokud dojde k namoceni monitoru, co
nejdrive jej osuste suchym hadrikem.

Vnikne-li do monitoru cizf ldtka nebo voda,
ihned vypnéte napdjeni a odpojte napdjecl
kabel. Odstrarite cizf ldtku nebo vodu

z monitoru a odeslete jej do servisniho
strediska.

Monitor neskladujte ani nepouzivejte
na mistech vystavenych teplu, prfmému
slunecnimu zdreni nebo extrémnim
teplotdm.

Chcete-li zachovat optimalnf vykonnost
monitoru a prodlouzit jeho Zivotnost,
pouZzivejte jej na mistg, které splfiuje
nasledujici rozsahy teplot a vihkosti.



1. Dilezite

* Teplota: 0-40°C 32-95°F
e Vlhkost: 20-80% relativni vinkosti

DULEZITE: Pfed ponechanim monitoru
bez dozoru vzdy aktivujte sporic¢ obrazovky.
Bude-li na vasem monitoru zobrazen
nemeénici se staticky obsah, vzdy aktivujte
aplikaci pro pravidelnou obnovu obrazovky.
Dlouhodobé neprerusované zobrazeni
nehybného nebo statického obrazu mize
zpusobit , vypdleni* obrazovky, rovnéz
znamé jako ,,dosvit" nebo ,,zobrazenf
duchd”.

,Vypéleni*, ,,dosvit" nebo ,,zobrazenf
duch(" je dobre zndmy jev u technologie
panelt LCD. V mnoha pripadech , vypéleni*,
,dosvit"* nebo ,,zobrazeni duchd* postupné
zmizi po urcité dobé mimo provoz.

D Vystraha

Vazné priznaky ,,vypdlenf”,, dosvitu" nebo
,zobrazenf duchd' nezmizf a nelze je opravit. Na
vySe uvedené poskozen( se nevztahuje zdruka.

Servis

Kryt pldsté maze oteviit pouze kvalifikovany
servisni pracovnik.

Pokud je pro opravu vyZadovdna
dokumentace nebo integrace, obrat'te se
na nejblizsi servisni stredisko. (Viz kapitola
, Stredisko zdkaznické péce")

Informace o prevézenf najdete v Casti

,, Technické udaje".

Neponechévejte monitor v auté nebo v
zavazadlovém prostoru auta na primém
slunci.

© Poznamka

Pokud monitor nefunguje sprdvné nebo pokud
si nejste jisti, jaké kroky je treba provést po
proveden( pokynt v této prirucce, obratte se na
servisniho pracovnika.

1.2 Vysvétleni zapisu

Nasledujici pododdily popisujf zpUsob zdpisu,
ktery se pouzivd v této prirucce.

Poznamky, upozornéni a vystrahy

Na strankdch této prirucky mizete narazit na
text, ktery je opatreny symbolem a je vytistén
tucné nebo kurzivou. Takové Useky obsahujf
pozndmky, upozomén a vystrahy. Jejich pouzitl
je nasledujict:

€& Pozniamka

Tento symbol oznacuje dlleZité informace a
navrhy, které poméhajf Iépe vyuzit pocitacovy
systém.

© Upozornéni

Tento symbol oznacuje informace, které
objasniujf, jak se vyhnout moznému poskozenf
zaffzen{ nebo ztrdte dat.

D Vystraha

Tento symbol oznacuje nebezpedi télesného
ubliZzenf a vysvétluje, jak se danému problému
vyhnout.

Nekteré vystrahy se mohou objevit v riizné
podobé a nemusf byt uvozeny symbolem.V
takovém pripade je konkrétni vyznaceni vystrahy
nar{zeno Uradem pro regulaci.



1.3 Likvidace produktu a obalového
materialu

Likvidace elektrickych a elektronickych
zafizeni - WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may

not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Recycling Information for Customers
Your display is manufactured with high quality

materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit www.philips.com/about/sustainability/

recycling.




2. Sestaveni monitoru

2.1 Instalace

El Obsah krabice

%%art

PHILIPS

o

VGA (nepovinny) DVI (nepovinny)

2] Namontujte stojanek podstavce

1.

Umistéte monitor obrazovkou dold na
mékky a hladky podklad, aby nedoslo k
poskrdbani obrazovky.

Pripojte sloupek podstavce k monitoru tak,
aby zaklapl do pozice.

Uchopte monitor obéma rukama a
pripevnéte stojdnek podstavce do sloupku
podstavce.




3 ] Pripojeni k poditaci

(1) Vstup stridavého napdjent

© VstupVGA

© Vstup DVI-D (k dispozici pro vybrané
modely)

O Audio vstup (k dispozici pro vybrané
modely)

© Zimek proti krddeZi Kensington

Pripojeni k poditaci

1. Pevné pripojte napdjeci kabel k zadnf strané
monitoru.

2. Vypnéte pocitac a odpojte jeho napdjecl
kabel.

3. Pripojte signdlovy kabel monitoru do video
konektoru na zadnf strané pocitace.

4. Zapojte napdjeci kabel pocitate a monitoru
do nejblizsi zdsuvky.

5. Zapné&te poditat a monitor. Jestlize se
na monitoru objevi obraz, instalace je
dokoncena.

2.2 Ovladani monitoru

(1] Popis vyrobku z ¢elniho pohledu

PHILPS 00000

Ll

Model 226V3LA:

(54
AUTO/ W 1/A 0/ 4 /0K 0)
6o 6 00 o o
Model 226V3L:
(5]
AUTO/VY /A O/« /0K 0)
6o 6 66 6 o

Slouzl k ZAPNUTI aVYPNUT(
napdjeni monitoru.

o o

Slouzi ke vstupu do nabidky
O /0K OsD.

Potvrzeni nastaveni OSD.

Slouzi k ndvratu na predchozf
o < drovers OSD.

(4] O-  |Nastaveni drovné jasu.
© | A V¥ [SlouZi k dpravdm nabidky OSD.
Slouzi k Upravé nastaven(
1 o
0 hlasitosti reproduktoru.

f |Zmé&na formatu zobrazent.

©@ | AUTO |Automatické nastaveni monitoru.




Bl Popis zobrazeni funkci na obrazovce Nabidka OSD
. . NiZe je uveden celkovy pohled na strukturu
dk: D)?
Co |elnab|, a na obrazovee (OSD) , OSD. Tento prehled mlzete vyuzit, budete-li
Funkci lnab|dky ObraZO\fky (On—Scrgen Display, chtit pozdéji prozkoumat riiznd nastavent.
OSD) jsou vybaveny viechny monitory
LCD Philips. Umozriuje koncovému uzivateli

upravovat vlastnosti obrazovky nebo vybirat
funkce monitoru prfmo prostrednictvim

Main menu Sub menu

VGA
zobrazeného okna s pokyny. Nize je uveden — Inpuc [
priklad prlemného rozhrani obrazovky: bV
(available for selective models)
Model 226V3LA:
Picture Format — Wide Screen, 4:3
— Picture
Brightness — 0~100
Contrast — 0~100
SmartContrast — On, Off
Stand-Alone — On, Off
— Audio [
Mute — On, Off

(available for selective models)

Color Temperature —— 6500K, 9300K
— Color
sRGB
User Define Red: 0~100
Green: 0~100
Blue: 0~100
— Language — English, Espariol, Frangais, Deutsch, Italiano,

Portugués, Pycckuin, A3, Turkge

— Horizontal — 0~100
— OSD Settings
— Vertical — 0~100
— Transparency — Off,1,2,3,4
L— OSD Time Out — 5s, 10s, 20s, 30s, 60s
LRI 100
1 L— Setup — Auto
— H. Position — 0~100
— V. Position — 0~100
— Phase — 0~100
— Clock — 0~100
— Resolution Notification — On, Off
— Reset — Yes, No
Zakladni a jednoduché pokyny k ovladacim _
L— Information

tlacitkdm

Ve vySe uvedené nabidce obrazovky OSD
mizete stisknutim tlacftek ¥ A na prednim
rdmecku monitoru pohybovat kurzorem a
stisknutim OK potvrdit vybér nebo zménu.



El Poznamka k rozligeni

Tento monitor je urcen pro optimalni vykon
pri nativnim rozliseni 1920 x 1080 pri 60 Hz.
Kdyz je monitor zapnut pri jiném rozlisenf, na
obrazovce se zobraz( vystraha: Pro optimaln{
vysledek poutzijte rozlisenf 1920 x 1080 pri 60
Hz.

Zobrazovan( vystrahy na nativni rozlisenf Ize
vypnout v ¢asti Setup (Nastaven() v nabidce
OSsD.

B Fyzické funkce
Naklon

2.3 Odpoijte stojanek podstavce a
podstavec

Bl Demontaz stojanku podstavce

Nez zacnete demontovat podstavec monitoru,

postupujte podle pokyni nize, aby se zabranilo

jakémukoli moznému poskozeni nebo zranént.

1. Umistéte monitor obrazovkou doli na
mekky podklad, aby nedoslo k poskrdbant
obrazovky.

2. Stisknéte zajistovaci svorky a oddélte
stojdnek podstavce od sloupku podstavce.

3. Pro odpojenf sloupku podstavce stisknéte
uvolriovacf tlacitko.




Bl Demontiz podstavce =) POZnémkal N

1. MUZete zasunout plochy $roubovék do Tento monitor je kompatibilni's T00mm x
dvou uvolfiovaci otvorli na krytu zavésu a 100mm montéznim rozhranim kompatibilnim
jemnym pacenim jej odstrarite. se standardem VESA.

100mm
100mm

2. Odmontujte 4 Srouby a potom sejméte
podstavec z monitoru.




3. Optimalizace Obrazu

3.1 SmartContrast

El Cojeto?

Jedine¢nd technologie, kterd dynamicky analyzuje
zobrazeny obsah a automaticky optimalizuje
kontrastni pomér monitoru LCD pro maximalnf
vizudlni Cistotu a pozitek ze sledovani. Zvysuje
podsviceni pro jasnéjsi, ostr'ejs a jasnéjsi obraz
nebo snizuje podsviceni pro jasné zobrazenf
obrazu s tmavym pozadim.

E3 Pro¢ to potrebuiji?

Zadéte nejvy¥ vizudlni gistotu a pohodl
sledovan( jakéhokoli typu obsahu. SmartContrast
dynamicky fdi kontrast a upravuje podsvicenf
pro jasné, ostré a jasné zobrazeni her a videa
nebo pro zobrazenf jasného, Citelného textu
pro kanceldrskou praci. Omezenim spotreby
monitoru Setrite ndklady a prodluzujete Zivot
vaseho monitoru.

E Jak to funguje?

Po aktivaci bude funkce SmartContrast v
redlném Case analyzovat zobrazeny obsah a
upravovat barvy a ridit intenzitu podsviceni. Tato
funkce bude dynamicky vylepsovat kontrast pro
skvély zdzitek pri prohlizenf fotografiif nebo hranf
her.

3.2 Philips SmartControl Lite

Novy software SmartControl Lite od
spolecnosti Phillips umozriuje ovlddat monitor
prostrednictvim snadno pouzitelného grafického
rozhrani na obrazovce. SloZitd nastaveni jsou
minulostf, protoze tento uzivatelsky prijemny
software vds provede jemnym vyladénim
rozli$eni, kalibraci barev, nastavenim frekvence/
faze, nastavenim bilého bodu RGB atd.

Tento software zalozeny na pritazlivych
animovanych ikondch kompatibilni se systémem
Windows 7, ktery je vybaven nejnovejsi
technologif v jddrovém algoritmu pro rychlé

zpracovan( a odezvu, je pripraven rozsifit vasi
zkusenost s monitory Philips!

El Instalace
» Postupujte podle pokynd a dokoncete
instalaci.

*  Mulzete spustit po dokoncenf instalace.

*  Chcete-li spustit pozdéji, mizete klepnout
na zdstupce na pracovni ploSe nebo na
panel nastrojl.

PHILIPS wer phita cooniicorr

Prvni spusténi —Wizard (Privodce)

*  Pri prvnim spusténi po instalaci prejde
SmartControl Lite automaticky na Wizard
(Prvodce).

» Tento privodce vés provede podrobnym
nastavenim vykonu monitoru.

*  Prdvodce mizete rovnéz spustit pozdgji z
nabidky Plug-in (Zasuvny modul).

*  Daldf moznosti mlzete nastavit bez
prdvodce prostrfednictvim podokna
Standard (Standardni).




3. Optimalizace Obrazu
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B3 Spusténi s podoknem Standard W e 117

(Standardni): SmartControl Lite PHILIPS

Nabidka Adjust (Nastaveni):
* Nabidka Adjust (Nastaveni) umozriuje

upravit Brightness (Jas), Contrast (Kontrast), ‘ Q

Focus

Focus (Ohnisko), Position (Poloha) a
Resolution (Rozlisent).

[

* MdZete postupovat podle pokyn( a provést =g -
nastaveni. E ﬁ = o %
»  Cancel (Storno) vyziva uZzivatele, chcete-li o '* - :
ukondit instalaci. ly = = s
Ootors #
WP Stz 3+ Pl 379 [CS30713000001) (i o Restiton
SmartControl Lite PHILIPS lg

Brighiness

=

Color

Position

_&_ SmartControl Lite PHILIPS
o

w - @
fr # s ":‘7. S— 3
@ - -
- -

4

s

b

[ Rt

i
in

"

10



3. Optimalizace Obrazu

Nabidka Color (Barva):

[ e

SmartControl Lite

&

®

Wixmisje

2- e 10w (cxerizo000nt) (T

PHILIPS

Nabidka Color (Barva) umozriuje upravit
RGB, Black Level (Uroveri cerné), White
Point (Bily bod), Color Calibration (Kalibrace

barev).

MUZete postupovat podle pokyntd a provést

nastaveni.

V nésledujici tabulce vyhledejte polozku
podnabidky na zdkladé vaseho vstupu.
Priklad pro Color Calibration (Kalibrace

barev)
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SmartControl Lite
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3. Optimalizace Obrazu

1. Tlacitko , Show Me" (Predvést) spusti
vyukovy program pro kalibraci barev.

2. Start (Spustit) — zahdji sekvenci kalibrace
barev o 6. krocich.

3. QuickView (Rychlé zobrazeni) nacte
zobrazeni pred/po.

4. Chcete-li se vrétit na hlavn( stranku Color
(Barva), klepnéte na tlacitko Cancel
(Storno).

5. Enable color calibration (Povolit kalibraci
barev) — ve vychoz konfiguraci je zapnuto.
Pokud tato polozka nenf zaskrtnuta, kalibraci
barev nelze provést a tlacitka rychlé
zobrazeni nejsou k dispozici.

6. Na kalibra¢ni obrazovce musi byt zobrazeny
informace o patentech.

Calibration Screen (Obrazovka kalibrace)
prvni barvy:

* Tlacftko Previous (Predchozi) je
deaktivovdno az na obrazovku druhé barvy.

*  Tlacftko Next (Dalsi) slouzi k prechodu na
nasledujici cil (6 cil).

»  Tlacitko Konecny slouzi k prechodu na File
> Presets (Soubor > podokno Predvolby).

* Tlacftko Cancel (Storno) slouzi k ukoncenf
uzivatelského rozhranf a k ndvratu na
strdnku zdsuvnych moduld plug-in.

Options>Preferences (Moznosti>Predvolby) —
Tato moznost bude aktivni pouze po vybéru
polozky Preferences (Predvolby) v rozeviraci
nabidce Options (Moznosti). Na nepodporova-
ném zobrazovacim zafizeni s podporou DDC/
Cl jsou k dispozici pouze karty Help (Ndpovéda)
a Options (Moznosti).

12
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Zobraz{ nastaven( aktudlnich predvoleb.
Zaskrtnuté tlacftko aktivuje funkci.
Zaskrtdvaci policko je prepinac.

Polozka Enable Context Menu (Povolit
mistni nabidku) na pracovni plose je ve
vychozf konfiguraci zaskrtnutd (Zapnuto).
Po aktivaci polozky Enable Context

Menu (Povolit mistni nabidku) se zobrazi
vybéry SmartControl Premium pro funkce
Select Preset (Vybrat predvolbu) a Tune
Display (Ladéni zobrazeni) na pracovni
plose klepnutim pravym tlacftkem mysi na
mistn{ nabidku. Volbou moZnosti Disabled
(Deaktivovdno) bude polozka SmartControl
Premium odstranéna z mistni nabidky
pravym tlacitkem mysi.

Polozka Enable Task Tray (Povolit ikonu na
hlavnim panelu) je ve vychozi konfiguraci
zaskrtnutd (Zapnuto). Po aktivaci polozky
Povolit mistnf nabidku se zobrazi nabidka
SmartControl Lite na hlavnim panelu.
Klepnutim pravym tlacitkem mysi na ikonu
na hlavnim panelu se zobrazi moZznosti
nabidky Help (Ndpovéda), Technical
Support (Odborna pomoc), Check for
Update (Vyhledat aktualizace), About

(O aplikaci) a Exit (Konec). Kdyz je
deaktivovdna polozka Enable task tray menu
(Povolit nabidku na hlavnim panelu), ikona
na hlavnim panelu zobrazuje pouze moznost
EXIT (KONEC).



* PoloZka Run at Startup (Spustit pfi startu) je
ve vychozi konfiguraci zaskrtnutd (Zapnuto).
Kdyz je tato polozka deaktivovana, funkce
SmartControl Lite se nespusti pri startu
nebo nebude na hlavnim panelu. Funkci
SmartControl Lite Ize spustit pouze
prostrednictvim zdstupce na pracovni
plose nebo prostrednictvim souboru
programu. Kdyz toto poli¢ko nenf zaskrtnuté
(Deaktivovdno), Zddnd predvolba nastavend
pro spustén( pfi startu nebude nactena.

* Enable transparency mode (Aktivovat reZim
prahlednosti) (Windows 7, Vista, XP).
Vychozi nastaveni je 0 % neprdhlednost.

Options>Input (Moznosti>Vstup) — Tato
moznost bude aktivni pouze po vybéru
polozky Input (Vstup) v rozeviraci nabidce
Options (Moznosti). Na nepodporovaném
zobrazovacim zarizen( s podporou DDC/CI
jsou k dispozici pouze karty Help (Ndpovéda)
a Options (Moznosti). Zadné dal¥f karty funkce
SmartControl Lite nejsou k dispozici.

[ p— . 1%

SmartControl Lite PHILIPS

Input

ERORTANT]

&
=

L
\ﬁ .

=

» Zobrazi podokno s pokyny Source (Zdroj)
a nastaven( aktudniho zdroje vstupu.

* U zobrazovacich zarizen( s jednim vstupem
nenf toto podokno zobrazeno.
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Options>Audio (Moznosti>Zvuk) —Tato
moznost bude aktivni pouze po vybéru polozky
Audio (Hlasitost) v rozeviraci nabidce Options
(Moznosti).

Na nepodporovaném zobrazovacim zarizen(' s
podporou DDC/CI jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).

P snartone L 13 x
SmartControl Lite PHILIPS

Audia

=
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Help>User Manual (Napovéda>Uzivatelska
pfirucka) —Tato moznost bude aktivni pouze
po vybéru polozky User Manual (Uzivatelskd
prirucka) v rozeviraci nabidce Help (Ndpovéda).
Na nepodporovaném zobrazovacim zafizeni' s
podporou DDC/CI jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).
SmartControl Lite

PHILIPS

U Manal

k 2 Toch. Support buts



Help>Version (Napovéda>Verze) —Tato
moznost bude aktivni pouze po vybéru
polozky Version (Verze) v rozeviraci nabidce
Help (Ndpovéda). Na nepodporovaném
zobrazovacim zarizeni s podporou DDC/CI
jsou k dispozici pouze karty Help (Ndpovéda) a
Options (Moznosti).
[Fye— 3. s 1238 rusosol) (T
SmartControl Lite PHILIPS

Version

Context Sensitive menu (Mistni nabidka)
Context Sensitive Menu (Mfstni nabidka) je
ve vychozi konfiguraci Aktivovana. Nabidka
bude zobrazena po zaskrtnuti polozky Enable
Context Menu (Povolit mistni nabidku) v casti
Options > podokno Preferences (Moznosti >
podokno Predvolby).

E SmartControl
Helect Preset L3
Tune Display

Context Menu (Mistni nabidka) obsahuje 3

polozky:

*  SmartControl Lite - po vybéru se zobrazf
obrazovka About (O) aplikaci.

*  Select Preset (Vybrat predvolbu) — nabizf
hierarchickou nabidku uloZenych predvoleb
pro okamzité pouziti. Aktudlné vybrand
predvolba je oznacena zaskrtnutim. V
rozeviraci nabidce Ize rovnéz vybrat polozku
Predvolby vyrobce.

* Tune Display (Ladéni zobrazeni) — otevi'e
ovlddaci panel SmartControl Lite.

Aktivovana nabidka hlavniho panelu

Nabidku hlavniho panelu lze zobrazit klepnutim
pravym tlacitkem mysi na ikonu SmartControl
Lite na hlavnim panelu. Klepnutim levym
tlacftkem Ize spustit aplikaci.

Help

Technical Support
Check for Update
About

Exik

Hlavni panel obsahuje pét polozek:

*  Help (Ndpovéda) — pristup k souboru
s User Manual (uzivatelskou priruckou):
Otevr'e soubor s User Manual (uzivatelskou
priruckou) v okné vychoziho prohlizece.

* Technical Support (Odbornd pomoc) —
zobrazi stranku odborné pomoci.

*  Check for Update (Vyhledat aktualizace) —
zobrazi Uvodnf strdnku PDI a porovnd verzi

* About (O aplikaci) — zobrazi podrobné
referen¢ni informace: verze produktu,
informace o vyddnf a ndzev produktu.

*  Exit (Konec) - ukon¢i SmartControl Lite

Chcete-li znovu spustit funkci SmartControl Lite,
vyberte polozku SmartControl Lite z nabidky
Program, poklepejte na ikonu na pracovni plose
pocftace nebo restartujte pocitac.

PHILIPS

T
SmartControl

SearControd
‘Verzion 120
‘dune-standard 8200701041 51.23
Copyright 19932007 Portrat Displays, Inc.
Paterty




Deaktivovana nabidka hlavniho panelu

Kdyz je hlavnf panel deaktivovdn ve sloZce
Preference (Predvolby), je k dispozici pouze
¢ast EXIT (KONEC). Cheete-li funkci
SmartControl Lite zcela odstranit z hlavniho
panelu, deaktivujte polozku Run at Startup
(Spustit pri startu) v ¢asti Options>Preferences
(MoZnosti>Predvolby).
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4. Technické udaje

Typ panelu LCD TFT-LCD
Podsvicenf LED

Velikost panelu 215" S (54,6 cm)
Pomér stran 16:9

Rozte¢ obrazovych bodud

0,248 x 0,248 mm

Jas 250 cd/m? or 200 cd/m?
SmartContrast 10.000.000:1

Kontrastni pomér (typ.) 1000:1 or 600:1

Doba odezvy (typicka) 5ms

Optimaln{ rozlisenf

1920 x 1080 pri 60 Hz

Vstup signdlu

Zorny uhel 170° (H) / 160° (V) pri C/R>10
or 90° (H) / 65° (V) pri C/R>10

Barevnost displeje 16,7M

Vertikdlni obnovovaci frekvence | 56Hz - 76Hz

Horizontdlni frekvence 30kHz - 83kHz

sRGB ANO

DVI-D (digitalni), VGA (analogovy)

Vstupni signdl

Usnadnénf pro uzivatele

Oddélend synchronizace, synchronizace podle zelené

226V3LA: auto/v (/A O/4 B/oK (0]
226V3L:  auTo/v  EX/A O/ 4 /0K 0)

Jazyky nabidky OSD

anglictina, francouzstina, némcina, italstina, rustina, Spanélstina,
zjednodusend ¢instina, portugalstina, turectina

Dalsi usnadnénf

Z3amek Kensington

Kompatibilita s technologif
Plug & Play

Naklon

DDC/CI, sRGB, Windows 7/Vista/XP, Mac OSX, Linux

-5/+20

226V3LA:

Zapnuto

221W (typ.), 22,89W (max.)

Spotreba energie (Metoda
testovani EnergyStar 5.0)

Strfdavé vstupnf
napéti pri T00VAC
+/-5VAC,

Stridavé vstupnf
napéti pri 115VAC
+/-5VAC,

Stridavé vstupnf
napéti pri 230VAC
+/-5VAC,

50Hz +/-3Hz 60Hz +/-3Hz 50Hz +/-3Hz
Normdlni provoz (typ.) 17,18W 1711W 19,08W
Spdnek (Pohotovost) 0,5W 0,5W 0,5W
Vypnuto 0,5W 0,5W 0,5W
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Strfdavé vstupnf Stridavé vstupni Stridavé vstupnf
Rozptyl tepla* isj_pse\‘%\)ngVAC r_:_e};_)se\’?ApgﬂSVAC r_:_;j[_)se\‘?/fg 230VAC

50Hz +/-3Hz 60Hz +/-3Hz 50Hz +/-3Hz
BéZzny provoz 58,63 BTU/hr 58,4 BTU/hr 65,12 BTU/hr
Spanek (Pohotovost) 1,706 BTU/hr 1,706 BTU/hr 1,706 BTU/hr
Vypnuto 1,706 BTU/hr 1,706 BTU/hr 1,706 BTU/hr
Indikdtor napdjenf Zapnuto: Bild, Pohotovostni rezim/rezim spanku: Bild (blika)
Napéjenf Vypdleni, 100-240VAC, 50-60Hz

226V3L:

21,3 W (typ.), 22,8W (max.
Zaplied or 187 W th)yp), 215 \(/v (m)ax) for 200nitd
Stridavé vstupnf Stridavé vstupni Stridavé vstupnf
Spotreba energie (Metoda napéti pri TOOVAC | napéti pri 115VAC | napéti pri 230VAC
testovani EnergyStar 5.0) +/-5VAC, +/-5VAC, +/-5VAC,
50Hz +/-3Hz 60Hz +/-3Hz 50Hz +/-3Hz
20,90 W 20,80 W 20,80 W
Normdlni provoz (typ.) or 19,10 W for or 19,00 W for or 19,10 W for
200nitd 200nitd 200nitd
Spének (Pohotovost) 0,5W 0,5W 0,5W
Vypnuto 0,5W 0,5W 0,5W
Stridavé vstupnf Stridavé vstupnf Stridavé vstupnf
Rozptyl tepla* rlafse\%\angVAC 13?5\?,58115\/AC ij)se\?;g 230VAC
50Hz +/-3Hz 60Hz +/-3Hz 50Hz +/-3Hz
BéZny provoz 71,33 BTU/hr 70,99 BTU/hr 70,99 BTU/hr
or 65,19 BTU/hr or 64,85 BTU/hr or 65,19 BTU/hr
for 200nitd for 200nitd for 200nitd
Spanek (Pohotovost) 1,706 BTU/hr 1,706 BTU/hr 1,706 BTU/hr
Vypnuto 1,706 BTU/hr 1,706 BTU/hr 1,706 BTU/hr
Indikdtor napdjenf Zapnuto: Bild, Pohotovostni rezim/rezim spanku: Bild (blikd)
Napéjenf Vypdleni, 100-240VAC, 50-60Hz
[Rozwry .
Vyrobek s podstavce (5xVxH) 532 x 397 x 209 mm
Vyrobek bez podstavee (SxVxH) | 532 x 336 x 51 mm
Vyrobek s podstavcem 3,61 kg
Vyrobek bez podstavce 33 kg
Vyrobek s obalem 4,78 kg
Teplotni rozsah (provoz) 0°C az 40 °C
Teplotni rozsah (mimo provoz) -20°C az 60°C
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4. Technické udaje

Prohldseni o shodé

Barva

Relativni vihkost 20% az 80%

T Pouziranf: + 12 000 stop (3 658 m)
Nadmorsid vySka Mimo provoz: + 40 000 stop (12 192 m)
MTBF 30 000 hod.

ROHS ANO
EPEAT Silver (www.epeat.net)
Balenf 100% recyklovatelny

CE Mark, FCC Class B, GOST, SEMKO, TCO Certified (Only for
selective models), UL/cUL, BSMI, ISO9241-307,C-Tick

Ceméd

Povrchovd dprava

Leskd/Textura

& Pozniamka

1. Certifikat EPEAT Gold nebo Silver je platny pouze tam, kde spole¢nost Philips zaregistruje produkt.
Informace o stavu registrace ve vasi zemi viz www.epeat.net.

N

www.philips.com/support.

Tyto Udaje se mohou zménit bez predchoziho ozndment. Stéhnéte si nejnovéjsi verzi letdku z webu
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4.1 Rezimy rozliSeni a prredvoleb

E Maximélni rozliSeni
1920 x 1080 pri 60 Hz (analogovy vstup)
1920 x 1080 pri 60 Hz (digitdlni vstup)

E3 Doporuéené rozliseni
1920 x 1080 pi 60 Hz (digitdInf vstup)

31,47 720 x 400 70,09
31,47 640 x 480 59,94
35,00 640 x 480 66,67
37,86 640 x 480 72,81
37,50 640 x 480 75,00
37,88 800 x 600 60,32
46,88 800 x 600 75,00
48,36 1024 x 768 60,00
60,02 1024 x 768 75,03
63,89 1280 x 1024 60,02
79,98 1280 x 1024 75,03
55,94 1440 x 900 59,89
70,64 1440 x 900 74,98
65,29 1680 x 1050 59,95
67,50 1920 x 1080 60,00
& Poznimka

Upozormiujeme vis, ze tento monitor funguje
nejlépe pri nativnim rozliseni 1920 x 1080 pri
60 Hz. Pro dosazeni optimaln( kvality zobrazenf
dodrzujte toto doporucené rozliSen.
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5. Rizeni spotreby

Pokud je v daném pocitaci nainstalovan software
nebo videokarta vyhovujicf normé DPM
organizace VESA, monitor dokdze automaticky
snizit svou spotrebu energie, neni-li pouzivan.
Pokud pocita¢ rozpoznad vstup z kldvesnice,

mysi nebo jiného vstupniho zarizeni, monitor se
automaticky ,,probudi*. Nésledujici tabulka uvadf
spotrebu energie a signalizaci této funkce pro

automatickou Usporu energie:

226V3LA:

ReZim VESA| Video | H-synch. | V-synch. | Spotieba energie | Barva indikdtoru LED
Aktivni | ZAP. | Ano Ano 221W (typ.) Bila
Spének VYP. Ne Ne <05W (typ.) B4 (blikd)
Vypnuto | VYP. - - <0,5W (typ.) VYP.
226V3L:
ReZim VESA| Video | H-synch. | V-synch. | Spotreba energie | Barva indikdtoru LED
21,3W (typ)
Aktivni [ ZAP. | Ano Ano  |or 187 W (typ) Bild
for 200nita
Spanek [ VYP. Ne Ne <05W (typ.) Bl (blikd)
Vypnuto | VYP. - - <05W (typ.) VYP.

Nasledujici konfigurace se pouziva pri mérenf
energetické spotreby tohoto monitoru.

*  Nativni rozliseni: 1920 x 1080

*  Kontrast: 50%

e Jas: 250 nitl or 200 nitd

*  Barevnd teplota: 6500 K s pIné bilym

vzorkem

& Poznimka
Tyto Udaje se mohou zménit bez predchoziho
ozndment.
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6. Informace o regulaci

Lead-free Product

Lead free display promotes
environmentally sound recovery

w and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community's
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This display is designed for both you and the
planet

The display you have just purchased
carries the TCO Certified label.

This ensures that your display is
designed, manufactured and tested according to
some of the strictest quality and environmental
requirements in the world. This makes for a
high performance product, designed with the
user in focus that also minimizes the impact on
the climate and our natural environment.

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

* Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, colour
and luminance uniformity and colour
rendering.

*  Products are tested according to rigorous
safety standards at impartial laboratories.

*  Electric and magnetic fields emissions as
low as normal household background
levels.

* Low acoustic noise emissions (when
applicable).

Some of the Environmental features of the
TCO Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS
or ISO 14001).

*  Very low energy consumption both in on-
and standby mode minimize climate impact.

* Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury
and lead (RoHS compliance).

* Both product and product packaging is
prepared for recycling.

* The brand owner offers take-back options.

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development

in co-operation with scientists, experts, users as
well as manufacturers all over the world. Since
the end of the 1980s TCO has been involved

in influencing the development of IT equipment
in a more user-friendly direction. Our labeling
system started with displays in 1992 and is

now requested by users and IT-manufacturers
all over the world. About 50% of all displays
worldwide are TCO certified.

For more information, please visit:
www.tcodevelopment.com

TCOF1058 TCO Document,Ver. 2.1

I[n Technology for you and the planet
CERTIFIED

(Only for selective models)



EPEAT

(www.epeat.net)
@&  The EPEAT (Electronic

Product Environmental

‘ 2% Assessment Tool) program
evaluates computer desktops,
laptops, and monitors based on 571 environ-
mental criteria developed through an extensive
stakeholder consensus process supported by
US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and select
desktop computers, notebooks and monitors
based on their environmental attributes. EPEAT
also provides a clear and consistent set of per-
formance criteria for the design of products, and
provides an opportunity for manufacturers to
secure market recognition for efforts to reduce
the environmental impact of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S
requirement that all registered products meet
ENERGY STAR's energy efficiency specificati-
ons, means that these products will consume
less energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

* EN60950-1:2006 (Safety requirement of
Information Technology Equipment).

e EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment).

*  EN61000-3-2:2006+A1:2009+A2:2009
(Limits for Harmonic Current Emission).

»  EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

e 2006/95/EC (Low Voltage Directive).

*  2004/108/EC (EMC Directive).

» 2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following

standards

* 15S09241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

»  GS EK1-2000:2009 (GS mark requirement).

*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

e MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

*  TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(www.energystar.gov)

h As an ENERGY STAR® Partner, we
have determined that this product

et meets the ENERGY STAR®

guidelines for energy efficiency.

& Note
We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following
two conditions: (1) this device may not cause
harmful interference, and (2) this device must
accept any interference received, including
interference that may cause undesired
operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de l'article
15 Des regles de la FCC. Ces limites sont
congues de facon a fourir une protection
raisonnable contre les interférences nuisibles
dans le cadre d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si l'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



6. Informace o regulaci

Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, I'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

*  Augmenter la distance entre 'équipement
et le récepteur.

* Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur.

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

This device belongs to catagory B devices as described in EM 55022, unless it is spacifi-
cally stated that it ia a Class A devics on the spscification labsl. The following applies to
devices in Class A of EN 55022 (radius of protection up to 30 meters). The usar of the
davics i ohiiged to take all stapa necassary to temove sources of intarfersnce io tels-
communication or ather devicss.

Fokud neni na typovém Stitku poSitade uvedeno, 28 spadd do do tfidy A podie EN 55022,

do ffidy B podie EN 55022, Pro zafizeni zefazend do tHidy A (chranné
pésma 30m) podie EN E5022 plati ndsleduicl Dojde-li k rulien! telekomunikadnich nebo
Jjch zafizani je utivatel povinnen provést takovd opatignl, aby nseni odstranil,

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so
on) should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/
T-42107 and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacji

Uszpdzerde powinno byt zasiane = priazds 7 przybaczonym obwodem ochronsym (gmiazdo 2
kalkizn). Wapdlpr m-;anc iz sohi urzgdzenda (komputer, monstor, drikarka) powinny by zsilane

2 1ep0 samegn
tnstalscja clekiryczna pomiexaczenia poinna sawiemt w prawaize oy repswawa achnane
precel wazciami, w pestaci berpiecentki o wirtodel mamionawe me wicksze] iz 184 (amperiw).

W celu catkewitego wylscamia uregdeenss ¢ stect zasilania, nalezy wyjat wivezke kabla
sasilajacepa # ginedka, kdre powinno srejdowa ssg w poblizn urzilzenia § by batwo dostepie.
Laak beaplecesfarwn "B” potwiendes zpodaedl urepdeena » wymagaidainl beeplecaiisroa
ueytkowania zawartymi w PN-S3T-42107 § PN-BAE46251

Pozostale instrukcje begpieczensiwa

* Nie mlezy urywad wiycsek sdapterowyeh lub usuwaé kolka abwodu ochronnega 2 wiyesk.
Jekeli kemsecne jest byese proedluzscza t naledy wkyé preediuiace 3-bylowega 2
i demn ol

System nn'll.ae iecyé proed magtym, ymi wzrostami bub spad-
kami napiecin, uywajse elamimatm, prrepicd, urzsdrenia depasowjicess i
berakldceniowegn irodia zasilania.
* DNaley upewnic sie, aby nic nie lefalo na ksblach systemu komputeroweo. oraz aby kable nie

byly umhieszczone W migjsca, pdsse imoina byloby na nie nadeptywad lub potyksd sig o nic.
* i maledy rolewad napaom s nayel plydn s syssen Koeputesony.

Nie maleqy whychat adnych g fw systemm iy moie

1o spowndowa pogar \uhpmm\e;r.(dcm poprzes avearcie chemenidn: wewngtranych

* Systems kopaternwy pasinien snajdowad sig 2 dala od graejnikiu i Sidel clepl Porsdto,
nie naleiy blokswad atwordw wentylacyjuych. Nabeiy unikat kladeensa lainych papserdn posd
kemputer oeas umiesrcrania kamputera w cinsym miejses ber mailiwaici cyriulaci powi-
etz wokil nisge.
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

S@ORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
ST@MTILFORSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
RAZHARERIIBE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schdden durch Rontgenstrahlen" festgelegten
Vorschriften.

Auf der Rickwand des Geriates befindet sich
ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
a5 Abs. 4 der Réntgenverordnung erfiilit
sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.
nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildrohre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhohte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

N ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAR NETZSTECKER UND
NETZKABELANSCHLURB LEICHT
ZUGANGLICH SIND.



6. Informace o regulaci
China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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7. Péce o zakazniky a zaruka

7.1 Postup pri vadnych pixelech
plochého panelu spolecnosti
Philips

Spolecnost Philips se snazi dodédvat vyrobky
nejvyssi kvality. Pouzivd nékolik nejpokrocilejdich
vyrobnich postupt vyroby v tomto odvétvi a
prosazuje prisnou kontrolu kvality. Defektlm
obrazovych bodl nebo dil¢ich obrazovych
bodl u paneld TFT LCD, které se pouzivajf

pro ploché monitory, se nicméné nékdy neda
zabrénit. Zadny vyrobce nemtize zarucit, ¥e
vSechny panely budou bez defektd obrazovych
bodu, ale spolecnost Philips zarucuje, ze kazdy
monitor s nepfijatelnym poctem defektd bude
v ramci zaruky opraven nebo vyménén.Tento
text vysvétluje jednotlivé druhy defektl na
pixelech a urcuje Unosnou drover chybovosti
pro kazdy druh. Aby bylo mozné uplatnit zdrucnf
opravu nebo vyménu, musi pocet defektnich
obrazovych bodU panelu TFT LCD presdhnout
tuto Uroveri Unosnosti. Na monitoru napriklad
nesmi byt vice defektnich dil¢ich obrazovych
bodl nez 0,0004 %. Ddle, protoze nékteré typy
kombinaci vad pixell jsou lépe postrehnutelné
nez jiné, stanovuje pro né spolecnost Philips
jeste vétsi ndroky na kvalitu. Tato norma se
dodrzuje celosvétove.

subpixely subpixely subpixely

v
pixely

Pixely a subpixely

Pixel, neboli obrazovkovy bod, se skldda ze tif
subpixeld v zdkladnich barvdch Cervené, zelené a
modré. Kdyz je mnoho pixell pohromadé, tvor{
obraz. Kdyz viechny subpixely urcitého pixelu
svith, jevi se tyto tri subpixely spole¢né jako
jediny bily pixel. Kdyz jsou viechny tmavé, jevi
se tyto tfi subpixely jako jeden cerny pixel. Dalsf
kombinace rozsvicenych a tmavych subpixell se
jevi jako pixely rliznych barev.

Druhy pixelovych vad

Vady pixell a subpixelt se na obrazovce
projevuji riznymi zpUsoby. Existuji dva druhy vad
pixelu a v rdmci téchto druht je nékolik typu
subpixelovych vad.

Defekty svétlych bod

Defekty svétlych bodl se projevuji jako
obrazové body nebo dil¢i obrazové body, které
vzdy sviti nebo jsou 'aktivni'. Svétly bod je dilei
obrazovy bod, ktery vystupuje z obrazovky, kdyz
je na monitoru zobrazena tmavé plocha. Existujf
nasledujici typy defektl svétlych bodd:

Jeden Cerveny, zeleny nebo modry subpixel

¢

Dva soundleZici subpixely:
- cerveny + modry = fialovy
- Cerveny + zeleny = Zluty

- zeleny + modry = svétle modry

Tri soundlezici rozsvicené subpixely (jeden bily
pixel).



€& Poznamka

Cerveny nebo modry svétly bod musf byt o
vice nez 50 procent jasnéjsi, nez sousedni body;
zeleny svétly bod je o 30 procent jasnéjsi, nez
sousedni body.

Defekty tmavych bodl

Defekty tmavych bodud se projevuf jako
obrazové body nebo dil¢f obrazové body, které
nikdy nesvitl nebo jsou ,,neaktivni'. Tmavy bod je
dil¢i obrazovy bod, ktery vystupuje z obrazovky,
kdyZ je na monitoru zobrazena svetld plocha.
Existuji nasledujici typy defektd tmavych bodl:

Vzdalenost pixelovych vad

ProtoZe vady pixell a subpixelt stejného

typu, které se vyskytuji blizko sebe, mohou byt
patrnéjsi, urcuje spolecnost Philips i tolerance na
vzdélenost vad pixeld.

Tolerance vad pixelQ

Aby bylo mozné uplatnit opravu nebo vyménu
kvadli defektnim obrazovym bodim v zdrué¢nf
dobé, musi panel TFT LCD plochého monitoru
Philips vykazovat defekty obrazovych bod
nebo dfl¢ich obrazovych bodd, které prekracujf
tolerance uvedené v ndsledujicich tabulkach.

KAZY JASNYCH BODU

PRIJATELNY POCET VAD

1 trvale sviticf bod 3
2 sousedn/ trvale svitici body 1
3 sousedni trvale sviticf body (nebo 1 trvale svitici bily bod) 0
Vzdalenost mezi dvéma kazy jasnych bod* >15 mm
Celkovy pocet kazt jasnych bodd viech typl 3

KAZY CERNYCH BODU
1 tmavy bod

PRIJATELNY POCET VAD
5 nebo méné

2 sousedni tmavé body

2 nebo méné

3 sousedni tmavé body

0

Vzddlenost mezi dvéma kazy cernych bodd*

>15 mm

Celkovy pocet kazl ¢ernych bodd viech typl

5 nebo méné

KAZy bodi celkem

Celkovy pocet kazt jasnych nebo ¢ernych bodud viech typl

PRIJATELNY POCET VAD

5 nebo méné

© Poznamka

1. 1 nebo 2 sousedni vadné body (1 barva) = 1 vadny bod
2. Tento monitor je kompatibilni se standardem ISO 9241-307. ( ISO 9241-307: Ergonimicky
pozadavek, analyza a metody testovani shody pro elektronickd zobrazovaci zarizen)



7.2 Péce o zakazniky & zaruka

Podrobné informace o zaruce a pozadavku na dodate¢nou podporu platné pro vasi oblast najdete na
webu www.philips.com/support. Rovnéz mizete kontaktovat mistni centrum péce o zdkazniky na nize

uvedenych telefonnich cislech.

Kontaktni informace pro oblast ZAPADNI EVROPY:

Zemé ASC Cislo zakaznické péce Cena
Germany Siemens 1&S +49 01803 386 853 €0,09
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 785 €010
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €009
Greece Allman Hellas +30 00800 3122 1223 Free of charge
[taly A-novo +39 840 320 041 €008
Netherlands E Care +31 0900 0400 063 €010
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens 1&S +43 0810 000206 €007
Belgium E Care +32 078 250851 €006
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Kontaktni informace pro oblast STREDNI A VYCHODNI EVROPY:

Telefonni stredisko ASC Cislo zakaznické péce
Belarus NA IBA +375 17 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV" Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
;egﬁ'tae f‘egm NA i Tee cloe, +381 11 20 70 684
Slovenia NA PC H.and +386 1 530 08 24
NA Comel +380 562320045
Hkraine NA gﬁ;‘;wice +38 044 245 73 31
— NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
NA Serware +36 12426331
Hungary :
NA Profi Service +36 1 814 8080

Kontaktni informace pro oblast LATINSKE AMERIKY:

Telefonni stfedisko Cislo zakaznické péce
Brazil 0800-7254101
Vermont
Argentina 0800 3330 856

Kontaktni informace pro Cinu:

Cina
Cislo zakaznické péce: 4008 800 008

Kontaktni informace pro SEVERNI AMERIKU:

Zemé Telefonni stredisko  ASC Cislo zakaznické pé&e
USA. TOS Teleplan (877) 835-1838
Canada Supercom Supercom (800) 479-6696
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Kontaktni informace pro oblast APMEA:

Telefonni ., a NPT
stredisko Cislo zakaznické péce
Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand NA Visual Group Ltd. 0800 657447
: Hong Kong:Tel: +852 2619 9639
Hong Kong / Macau | NA Smart Pixels Technology Ltd. MacauTel: (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS to 56677
Indonesi NA PT. Gadingsari elektronika Tel: 62 21 75909053, 75909056,
onesa Prima 7511530
South Korea NA PCS One Korea Ltd. 080-600-6600
. After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 273741116
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer (65) 6882 3999
Care Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA s Computer System €O (66) 934-5498
South Africa NA Sylvara Technologies Pty Ltd | 086 0000 888
Unllted Arab NA AL SHAHD COMPUTER 00971 4 2276525
Emirates LLC
Israel NA Eastronics LTD 1-800-567000
. : +84 8 38248007 Ho Chi Minh City
Vietnam NA FCF;TmSZr;"CftZ‘forma“c +84 5113.562666 Danang City
ey B +84 5113562666 Can tho Province
- : (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no d?strlbutor and/or service
provider currently
Bancladesh NA Distributor: Computer Source | 880-2-9141747, 9127592
g Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty | 855-023-999992
buy-out)
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8. Odstranovani problému a
Casté dotazy

8.1 Odstranovani problému

Na této strdnce jsou uvedeny problémy,
které mlZe odstranit uZivatel. Pokud problém
pretrvavd i po vyzkouseni téchto resent,
kontaktujte zdstupce sluzeb pro zdkazniky
spolecnosti Philips.

El B&Zné problémy

Zadny obraz (indikator LED napajeni nesviti)

»  Zkontrolujte, zda je napdjec( kabel pripojen
k elektrické zdsuvce a do zadnf &3sti
monitoru.

*  Nejdrive zkontrolujte, zda se vypinac na
predni strané monitoru nachdzi ve OFF
(VYPNUTE) poloze a stisknéte jej do ON
(ZAPNUTE) polohy.

Zadny obraz (indikator LED napajenti je bily)

e Zkontrolujte, zda je zapnuty pocitac.

e Zkontrolujte, zda je kabel signdlu rddné
pripojen k pocitadi.

» Zkontrolujte, zda nejsou ohnuté koliky na
pripojovac( strané kabelu monitoru. Pokud
ano, opravte nebo vymérte kabel.

*  Pravdépodobné je aktivovdna funkce rizenf
spotreby

Obrazovka rika

Attention

Check cable connection

» Zkontrolujte, zda je kabel monitoru rddné
pripojen k pocitaci. (Rovnéz viz Stru¢nd
prirucka).

e Zkontrolujte, zda nejsou ohnuté koliky
kabelu monitoru.

»  Zkontrolujte, zda je zapnuty pocital.

Tlaéitko AUTO nefunguje
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* Automaticka funkce je pouZitelnd pouze
v rezimu VGA-analogovy. Pokud vysledek
nenf uspokojivy, mizete provést ru¢ni
Upravy prostrrednictvim nabidky OSD.

© Pozniamka
Automatickd funkce nenf pouzitelnd v
rezimu DVI-digitdIni, protoZe je zbytecnd.

Viditelné znamky koure nebo jiskreni

*  Neprovddéjte Zddné kroky pro odstrafiovan{
problémé

*  Pro zajisténi bezpecnosti ihned odpojte
monitor od zdroje napdjenf

* |hned kontaktujte zdstupce sluzeb pro
zdkazniky spolecnosti Philips.

Ed Problémy se zobrazenim

Obraz neni vystredén

*  Upravte polohu obrazu pomocf funkce
,Auto” v hlavnich ovladacich prvcich OSD.

*  Upravte polohu obrazu pomoci polozek
Phase/Clock (Féze/frekvence) v ¢asti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddaci prvky OSD). Tato funkce je platnd
pouze v rezimu VGA.

Obraz se chvéje na obrazovce

e Zkontrolujte, zda je kabel signdlu rddné a
bezpedné pripojen ke grafické desce nebo k
pocitadi.

Dochazi ke svislému blikani

*  Upravte polohu obrazu pomocf funkce
, Auto” v hlavnich ovladacich prvcich OSD.
*  Omezte svislé pruhy pomoci polozek
Phase/Clock (Faze/frekvence) v ¢asti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddaci prvky OSD). Tato funkce je platnd
pouze v rezimu VGA.

Dochazi k vodorovnému blikani

M




*  Upravte polohu obrazu pomocf funkce
,Auto” v hlavnich ovlddacich prvcich OSD.

*  Omezte svislé pruhy pomoci polozek
Phase/Clock (Faze/frekvence) v ¢asti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddaci prvky OSD). Tato funkce je platnd
pouze v rezimu VGA.

Obraz je rozmazany, nevyrazny nebo prilis
tmavy
*  Upravte kontrast a jas na obrazovce OSD.

,Dosvit®, ,,vypaleni* nebo ,,zobrazeni duchi*

zlstane po vypnuti napjeni.

*  Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu muze
zpUsobit ,,vypdleni* obrazovky, rovnéz
zndmé jako ,,dosvit" nebo ,,zobrazenf
duchl'. ,,Vypdleni*, ,dosvit"* nebo
,zobrazen( duch(" je dobre zndmy jev
u technologie paneld LCD. V mnoha
pripadech , vypdleni”, ,,dosvit"* nebo
,,zobrazeni duchd' postupné zmizf po urcité
dobé& mimo provoz.

* Pred ponechdnim monitoru bez dozoru
vzdy aktivujte spori¢ obrazovky.

*  Bude-li na vaSem monitoru LCD zobrazen
neménici se staticky obsah, vzdy aktivujte
aplikaci pro pravidelnou obnovu obrazovky.

*  Véiné priznaky ,vypdleni*, ,dosvitu" nebo
,zobrazeni duch(" nezmizi a nelze je
opravit. Na vySe uvedené poskozenf se
nevztahuje zdruka.

Obraz je zdeformovany. Text je nejasny nebo

rozmazany.

* Nastavte rozlisenf zobrazeni pocitace na
stejny rezim, v jakém se nachdzf doporucené
nativni rozlisenf obrazovky monitoru.

Na obrazovce se objevuji zelené, cervené,

modré, tmavé a bilé tecky

e Zbyvajicl body jsou normdini viastnostf
tekutych krystald pouZivanych soucasnou
technologif. Dal$f podrobnosti viz pravidla
pro obrazové body.

Svétlo indikatoru ,,napajeni* je prilis silné a

rusi
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* MdZete nastavit intenzitu svétla indikdtoru
,napdjeni v &asti Power LED (Indikdtor
LED napdjeni) v casti Setup (Nastaven)

v OSD Main Controls (Hlavni ovlddaci prvky
nabidky OSD).

Potrebujete-li dalSi pomoc, viz seznam
Informacnf strrediska pro zdkazniky a kontaktujte
zéstupce sluzeb pro zdkazniky spolecnosti Philips.

8.2 Obecné casté dotazy

OTAZKA 1: Kdyz nainstaluji svij monitor, co
mam udélat, kdyz se na obrazovce
zobrazi zprava ,,Cannot display this
video mode* (Tento rezim videa
nelze zobrazit)?

Doporucené rozlisen pro tento

monitor: 1920 x 1080 pii 60 Hz.

*  Odpojte viechny kabely, potom pripojte
pocitac k monitoru, ktery jste pouZili predtim.

* V Start Menu (nabidce Start) operacniho
systému Windows vyberte Settings/Control
Panel (Nastaveni/Ovlddaci panely). V okné
Control Panel (Ovlddaci panely) vyberte
ikonu Display (Zobrazeni). Na panelu Display
Control (Zobrazeni — vlastnosti) vyberte kartu
,Settings' (Nastaveni). Na karté nastaven?

v poli ozna¢eném , desktop area™ (pracovn(
plocha) presurite posuvnik na 1920 x 1080
obrazovych bod.

*  Klepnéte na ,, Advanced Properties” (Upresnit),
nastavte polozku Refresh Rate (Obnovovaci
frekvence) na 60 Hz a potom klepnéte na OK.

*  Restartujte pocitac a zopakovdnim kroku 2 a 3
ovérte, zda je pocita¢ nastaven na 1920 x 1080
pfi 60 Hz.

*  Vypnéte pocita¢, odpojte stary monitor a
znowvu pripojte monitor LCD Philips.

*  Zapnéte monitor a potom zapnéte pocitac.

Odpovéd:

OTAZKA 2: Jaka je doporucena obnovovaci
frekvence monitoru LCD?
Doporucend obnovovaci frekvence
u monitord LCD je 60 Hz. V pripadé
jakéhokoli ruseni na obrazovce ji
mUZete nastavit na 75 Hz a uvidite,
zda ruseni zmizi.

Odpovéd:



OTAZKA 3:

Odpovéd:

OTAZKA 4:
Odpovéd:

OTAZKA 5:

Odpoveéd:

OTAZKA 6:

Odpovéd:

OTAZKA 7:

Odpoveéd:

Co jsou soubory .inf a .icm na disku
CD-ROM? Jak Ize nainstalovat
ovladace (.inf a .icm)?

Jedna se o soubory ovladace
monitoru. Pri instalaci ovladacd
postupujte podle pokynl v
uzivatelské prirucce. Pfi prvni instalaci
bude pocita¢ pravdépodobné
pozadovat ovladace monitoru
(soubory .inf a .icm) nebo disk s
ovladaci. Postupujte podle pokyn( a
vlozte (doprovodny disk CD-ROM),
ktery je soucdsti této sady. Ovladace
monitoru (soubory .inf a .icm)
budou nainstalovdny automaticky.

Jak mam upravit rozliseni?
Dostupna rozliseni urcuje graficka
karta/ovladac grafiky a monitor.
Pozadované rozliseni mizete vybrat
v Casti Control Panel (Ovladacf
panely) systému Windows® v &sti
,Display properties" (Zobrazenf -
vlastnosti).

Co kdyz se béhem nastaveni
monitoru ztratim prostrrednictvim
nabidky OSD?

Jednoduse stisknéte tlacitko OK a
potom volbou ,,Reset" (Obnovit)
obnovte vSechna plvodni nastaven(
vyrobce.

Je obrazovka LCD odolna proti
poskrabani?

Obecné se doporucuje nevystavovat
povrch panelu nadmérmym udderlm
a chranit jej pried ostrymi nebo
tupymi predmeéty. Pri manipulaci

s monitorem nevyvijejte na povrch
panelu zddny tlak ani silu. Mohlo by
to negativné ovlivnit vase zarucnf
podminky.

Jak Ize &istit povrch monitoru
LCD?

Pro bézné cisténi pouzijte Cisty
a mekky hadrik. Pro ddkladné
cisténi pouzijte izopropyl
alkohol. Nepouzivejte zadna jina
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rozpoustedla, jako etylalkohol,
etanol, aceton, hexan atd.

OTAZKA 8: Lze ménit nastaveni barev
monitoru?
Odpovéd:  Ano, nastaveni barev mizete zménit

prostrednictvim nabidky OSD podle
nasledujicich krokd:

e Stisknutim tlacitka ,,OK" zobrazte nabidku
OSD.

+  Stisknutim tla¢ftka ,,Down" (Sipka dolt)
vyberte volbu ,,Color (Barva) a stisknutim
tlacitka ,,OK" prejdéte na nastaveni barev. K
dispozici jsou ti nastaven( (viz nize).

1.

Color Temperature (Teplota barev):

k dispozici je dvou nastavenf: 6500K a
9300K. Pri nastaven( v rozsahu 6500K
vypadajf barvy na panelu ,teplé s
¢ervenobilym barevnym ténem", zatimco
pri nastaven( teploty 9300K vypadajf
barvy na panelu ,,studené s modrobilym
barevnym ténem".

sRGB: standard pro zajisténi spravné
prenosu barev mezi rliznymi zarizenimi
(napr. digitalni fotoapardty, monitory,
tiskdrny, skenery atd.)

User Define (Uzivatelské): uzivatel si mize
zvolit vlastni nastaven( barev upravenim
Cervené, zelené a modré slozky.

© Poznamka:

Méreni svétla barvy, které vyzaruje predmeét pri
zahrfvdni. Toto mérenf je vyjddieno v absolutnim
méritku (stupné Kelvina). Nizs( teploty Kelvina,
napriklad 2004K, jsou Cervené; vyssi teploty, jako
napriklad 9300K, jsou modré. Neutrdlni teplota je
bild pri 6504K.

OTAZKA 9:  Lze pfipojit tento monitor LCD
k libovolnému poéitaci, pracovni
stanici nebo pocitaci Mac?

Odpovéd: Ano.Vsechny monitory LCD

Philips jsou pIné kompatibilni se
standardnimi poditaci, pocitaci
Mac a pracovnimi stanicemi. Pro
pripojeni monitoru k systému
Mac muze byt zapotrebf kabelovy
adaptér. Dal3f informace vdm

zastupce Philips.



8. Odstranovani problémi a casté dota
OTAZKA 10:

Odpovéd:

OTAZKA 11:

Odpovéd:

D Vystraha

Jsou monitory Philips LCD
vybaveny technologii Plug-and-
Play?

Ano, tyto monitory jsou
kompatibilni s technologi Plug-
and-Play v operacnim systému
Windows 7,Vista, XP NT, Mac
OSX a Linux.

Co znamena Ipéni obrazu,
vypaleni obrazu, dosvit nebo
,»duch® v souvislosti s panely
LCD?

Dlouhodobé neprerusované
zobrazeni nehybného nebo
statického obrazu mdze zplsobit
,vypdleni* obrazovky, rovnéz
znamé jako ,,dosvit" nebo
,,zobrazeni duch”. ,Vypdleni*,
,dosvit" nebo ,,zobrazeni duchd"
je dobre zndmy jev u technologie
panell LCD.V mnoha pripadech
,vypdleni™, ,,dosvit" nebo
,zobrazenf duchd" postupné zmizf
po urcité dob& mimo provoz.
Pred ponechdnim monitoru bez
dozoru vzdy aktivujte sporic
obrazovky.

Bude-li na vaSem monitoru LCD
zobrazen neménic( se staticky
obsah, vzdy aktivujte aplikaci pro
pravidelnou obnovu obrazovky.

Vazné priznaky ,vypaleni, , dosvitu" nebo
,zobrazeni duch(l" nezmizf a nelze je opravit. Na
vySe uvedené poskozeni se nevztahuje zdruka.

OTAZKA 12: Pro¢ se na displeji nezobrazuje

Odpovéd:

ostry text a pro¢ maji
zobrazené znaky zubaté okraje?
V4s monitor nejlépe pracuje pri
svém nativnim rozliseni 1920

x 1080 pri 60 Hz. Pouzivejte
toto rozlisenf pro dosazenf
optimédlntho zobrazenf.

35



PHILIPS

AN
%

2012 © Koninklijke Philips Electronics N.V. Vsechna prava vyhrazena.
Philips a emblém Stitu Philips jsou registrované obchodni znamky
Koninklijke Philips Electronics N.V. a jsou pouzivany v licenci od
Koninklijke Philips Electronics N.V.

Udaje mohou byt bez piedchoziho upozornéni zménény.

Verze: M3226V2T



